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MODUL 1 

PENGENALAN ESP32 BOARD 

 

1.1. ESP32 Board 

ESP32 adalah chip dengan WiFi 2.4 GHz dan bluetooth dengan desain teknologi 40 nm 

yang dirancang untuk daya dan kinerja radio terbaik yang menunjukkan ketahanan, 

keserbagunaan dan keandalan dalam berbagai aplikasi dan skenario daya (Espressif Sistem, 

2019). ESP32 merupakan sebuah modul mikrokontroler dengan fitur mode ganda yakni WiFi 

dan bluetooth yang digunakan untuk mempermudah pengguna dalam membuat berbagai sistem 

aplikasi dan projek berbasis IoT (Internet of Things). ESP32 adalah mikrokontroler yang 

diperkenalkan oleh Espressif System dan merupakan penerus dari ESP8266, ESP32 memiliki 

banyak fitur tambahan dan keunggulan dibandingkan generasi sebelumnya. Pada ESP32 

terdapat inti CPU serta Wi-Fi yang lebih cepat, GPIO yang lebih banyak, dan dukungan 

terhadap Bluetooth 4.2, serta konsumsi daya yang rendah, sehingga sangat cocok untuk 

membuat beberapa proyek-proyek elektronika berbasis Internet of Things. Bentuk fisik Modul 

ESP32 dapat dilihat pada Gambar 4. 

 

Gambar 4. Bentuk fisik Modul ESP32 

 
 

a. Spesifikasi ESP32 

Keluarga ESP32 termasuk dalam chip ESP32-D0WDQ6 (ESP32-D0WD), ESP32- 

D2WD, ESP32-S0WD, dan sistem dalam paket (SiP) ESP32-PICO-D4. Mikroprosesor yang 

digunakan oleh ESP32 adalah Tensilica Xtensa LX6 dual-core atau single-core dengan clock 

rate hingga 240 MHz. Dengan rilisnya ESP32, Espressif System juga menawarkan fitur-fitur 

yang tertanam pada ESP32, dimana dengan dimensi yang kecil (25.5 x 18.0 x 2.8mm) modul 
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ini sangat mudah digunakan karena komponennya sudah terintegrasi dengan built-in antenna 

switches, RF balun, power amplifier, low-noise receive amplifier, filters, and power 

management modules. ESP32 memiliki spesifikasi seperti yang ditampilkan oleh Tabel 1. 

Tabel 1. Spesifikasi ESP32 
 

Categories Item Specification 

Certification • RF certification 

 

• Wi-Fi certification 

• Bluetooth certification 

• Green certification 

FCC/ CE-RED/ IC/ TELEC/ KCC/ 

SRRC/ NCC 

Wi-Fi Alliance 

BQB 

RoHS/REACH 

Test Reliability HTOL/HTSL/uHAST/TCT/ESD 

WiFi • Protocols 

 

 

 

 

 

• Frequency range 

802.11 b/g/n (802.11n up to 150 

Mbps) 

A-MPDU and A-MSDU 

aggregation and 0.4 µs guard 

interval support 

2.4 GHz ~ 2.5 GHz 

Bluetooth • Protocols 

 

• Radio 

 

 

• Audio 

Bluetooth v4.2 BR/EDR and BLE 

specification 

NZIF receiver with –97 dBm 

sensitivity Class-1, class-2 and 

class-3 transmitter AFH 

CVSD and SBC 

Hardware • Module interfaces On- 

chip 

 

 
 

• On-chip sensor 

• Integrated crystal 

• Integrated SPI flash 

• Operating voltage / 

Power supply 

SD card, UART, SPI, SDIO, I2C, 

LED PWM, Motor PWM, I2S, IR, 

pulse counter, GPIO, capacitive 

touch sensor, ADC, DAC 

Hall sensor 

40 MHz crystal 

4 MB 

2.7 V ~ 3.6 V 

 
 

Average: 80 mA 
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• Operating current 

• Minimum current 

delivered by power 

supply 

• operating temperature 

range 

 
500 mA 

 

 

 
–40 °C ~ +85 °C (18.00±0.10) 

Sumber : (Espressif, 2020) 

 
 

b. Keunggulan ESP32 

Keunggulan mikrokontroler ESP32 dibanding dengan mikrokontroler yang lain, terlihat 

dari pin out nya yang lebih banyak, pin analog lebih banyak, memori yang lebih besar, terdapat 

bluetooth 4.0 low energy serta tersedia WiFi yang memungkinkan untuk mengaplikasikan 

Internet of Things (IoT) dengan mikokontroler ESP32 (Imran, 2020). Perbedaan ESP32 dengan 

mikrokontroler lain ditunjukan pada Tabel 2. 

Tabel 2. Perbedaan ESP32 dengan mikrokontroler lain 
 

Variabel Data Arduino Uno 
NodeMCU 

(ESP8266) 
ESP32 

Tegangan 5 Volt 3.3 Volt 3.3 Volt 

CPU 
ATmega328 - 

16MHz 

Xtensa single core 

L106 - 60 MHz 

Xtensa dual core 

LX6 - 160M Hz 

Arsitektur 8 bit 32 bit 32 bit 

Flash Memory 32kB 16MB 16MB 

SRAM 2kB 160kB 512kB 

GPIO Pin 

(ADC/DAC) 
14 (6/-) 17 (1/-) 36 (18/2) 

Bluetooth Tidak ada Tidak ada Ada 

WiFi Tidak ada Ada Ada 

SPI/I2C/UART 1/1/1 2/1/2 4/2/2 

Sumber : (Imran, 2020) 

 

 

c. Konfigurasi Pin ESP32 

Chip ESP32 memiliki 48 pin dengan fungsi yang berbeda-beda, tidak semua pin dapat 

dilihat pada chip ESP32 dan ada beberapa pin yang tidak dapat digunakan Gambar 5 
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menunjukan konfigurasi pin chip ESP32. Fitur-fitur pada chip ESP32 diantaranya (Rui Santos 

& Santos, 2018): 

1. 18 Analog-to-Digital Converter (ADC) channels 

2. 3 SPI interfaces 

3. 3 UART interfaces 

4. 2 I2C interfaces 

5. 16 PWM output channels 

6. 2 Digital-to-Analog Converters (DAC) 

7. 2 I2S interfaces 

8. 10 Capacitive sensing GPIOs 
 
 

Gambar 5. Konfigurasi pin chip ESP32 

 
d. Board ESP32 DEVKIT 

Espressif System mengeluarkan beberapa model board ESP32 untuk menunjang para 

pengguna yang ingin membuat proyek elektronika berbasis Internet of Things, salah satu model 

yang dikeluarkan oleh Espressif System yaitu ESP32 Development Kit (Board untuk membuat 

aplikasi IoT dengan ESP32) atau ESP32 DEVKIT V1. Bentuk fisik Board ESP32 DEVKIT 

V1 dapat dilihat pada Gambar 6. Fitur-fitur dasar pada board ESP32 DEVKIT V1 diantaranya 

(Rui Santos & Santos, 2018) : 

1. Jumlah pin : 30 meliputi pin tegangan dan GPIO. 

2. 15 pin ADC (Analog to Digital Converter) 

3. 3 UART Interface 

4. 3 SPI Interface 

5. 2 I2C Interface 
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6. 16 pin PWM (Pulse Width Modulation) 

7. 2 pin DAC (Digital to Analog Converter) 
 

Gambar 6. Bentuk fisik Board ESP32 DEVKIT 

 

 

e. Konfigurasi Pin ESP32 DEVKIT V1 

Pada board ESP32 DEVKIT V1 terdapat 25 pin GPIO (General Purpose Input Output) 

dengan masing – masing pin mempunyai karakteristik tersendiri. Selain itu, ada pin dengan 

fitur khusus yang membuatnya cocok untuk digunakan atau tidak untuk digunakan pada proyek 

tertentu. Gambar 7 menunjukan Konfigurasi Pin ESP32 DEVKIT V1. 

 
 

Gambar 7. Konfigurasi Pin ESP32 DEVKIT V1 

 

 

Tabel 3 menunjukan penggunaan pin ESP32 DEVKIT V1. Di mana pin-pin yang 

digunakan sebagai input, output, dan pin-pin yang tidak perlu untuk digunakan. 
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Tabel 3. Penggunaan Pin ESP32 DEVKIT V1 
 

GPIO Input Output Notes 

0 Pulled up OK Outputs PWM signal boot 

1 TX Pin OK Debug output at boot 

2 OK OK Connected to on-board LED 

3 OK RX Pin High at boot 

4 OK OK  

5 OK OK Outputs PWM signal at boot 

6 × × Connected to the integrated SPI Flash 

7 × × Connected to the integrated SPI Flash 

8 × × Connected to the integrated SPI Flash 

9 × × Connected to the integrated SPI Flash 

10 × × Connected to the integrated SPI Flash 

11 × × Connected to the integrated SPI Flash 

12 OK OK  

13 OK OK Output PWM signal at boot 

14 OK OK Output PWM signal at boot 

15 OK OK  

16 OK OK  

17 OK OK  

18 OK OK  

19 OK OK  

20 OK OK  

21 OK OK  

22 OK OK  

23 OK OK  

24 OK OK  

25 OK OK  

26 OK OK  

27 OK OK  

28 OK OK  
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29 OK OK 

30 OK OK 

31 OK OK 

32 OK OK 

33 OK OK 

34 OK  

35 OK  

36 OK Input only 

37 OK Input only 

38 OK Input only 

39 OK Input only 

Sumber : https://www.studiopieters.nl/esp32-pinout/ 

 

f. Klasifikasi Pin GPIO ESP32 DEVKIT V1 

GPIO 34 hingga 39 adalah GPIO untuk pin input saja. Pin ini tidak memiliki resistor pull-

up atau pull-down internal. Mereka tidak dapat digunakan sebagai output, pin GPIO ini yang 

dapat digunakan hanya sebagai input diantaranya: 

1. GPIO 34 

2. GPIO 35 

3. GPIO 36 

4. GPIO 39 

Adapun Pin GPIO 14 sampai 23 memiliki internal pull-up, dimana pin GPIO ini dapat 

diatur menggunakan program untuk mengaktifkan pull-up yang dapat mempengaruhi suatu I/O 

agar dapat bekerja, pin GPIO yang dapat digunakan diantaranya: 

1. GPIO14 

2. GPIO16 

3. GPIO17 

4. GPIO18 

5. GPIO19 

6. GPIO21 

7. GPIO22 

8. GPIO23 

http://www.studiopieters.nl/esp32-pinout/
http://www.studiopieters.nl/esp32-pinout/
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Kemudian pin GPIO yang tidak memliki internal pull-up dapat ditambahkan pull-up 

eksternal sendiri seperti menggunakan resistor pull-up, adapun pin GPIO yang tidak memiliki 

internal pull-up diantaranya: 

1. GPIO13 

2. GPIO25 

3. GPIO26 

4. GPIO27 

5. GPIO32 

6. GPIO33 

ESP32 memiliki saluran input ADC 18 x 12 GPIO tersebut dapat digunakan sebagai ADC 

dan saluran masing-masing, Pin GPIO yang dapat digunakan sebagai ADC diantaranya: 

1. ADC1_CH0 (GPIO 36) 

2. ADC1_CH1 (GPIO 37) 

3. ADC1_CH2 (GPIO 38) 

4. ADC1_CH3 (GPIO 39) 

5. ADC1_CH4 (GPIO 32) 

6. ADC1_CH5 (GPIO 33) 

7. ADC1_CH6 (GPIO 34) 

8. ADC1_CH7 (GPIO 35) 

9. ADC2_CH0 (GPIO 4) 

10. ADC2_CH1 (GPIO 0) 

11. ADC2_CH2 (GPIO 2) 

12. ADC2_CH3 (GPIO 15) 

13. ADC2_CH4 (GPIO 13) 

14. ADC2_CH5 (GPIO 12) 

15. ADC2_CH6 (GPIO 14) 

16. ADC2_CH7 (GPIO 27) 

17. ADC2_CH8 (GPIO 25) 

18. ADC2_CH9 (GPIO 26) 

Terdapat saluran DAC 2 x 8 bit pada ESP32 untuk mengubah sinyal digital menjadi 

keluaran sinyal tegangan analog. Pin GPIO yang dapat digunakan sebagai DAC diantaranya : 

1. DAC1 (GPIO25) 

2. DAC2 (GPIO26) 
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ESP32 memiliki dua saluran I2C yang dapat diatur sebagai SDA atau SCL. Pin I2C 

default pada ESP32 DEVKIT diantaranya adalah: 

1. GPIO 21 (SDA) 

2. GPIO 22 (SCL) 

 
 

1.2. Instalasi Board ESP32 DEVKIT 

Untuk melakukan pemrograman pada board ESP32 DEVKIT diperlukan sebuah 

software yang kompatibel dalam membuat program, software yang digunakan untuk 

memprogram board tersebut dapat menggunakan Arduino IDE, karena Arduino IDE memiliki 

fitur untuk memilih banyak jenis-jenis board salah satunya ESP32. Langkah-langkah untuk 

menginstall board ESP32 DEVKIT pada Arduino IDE diantaranya : 

1. Buka Arduino IDE. 

2. Kemudian, pilih File > Preferences akan tampil jendela Preferences, seperti 

Gambar 8. 

 

Gambar 8. Tampilan Menu File 

3. Pada kolom “Additional Boards Manager URLs:” isikan: 

https://dl.espressif.com/dl/package_esp32_index.json, seperti Gambar 9. 

 

Gambar 9. Tampilan Jendela Preferences 
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4. Buka Boards Manager dari menu Tools > Board > Boards Manager …, seperti 

Gambar 10. 

 

Gambar 10. Tampilan Pemilihan Board 

 

 
5. Ketikan “ESP32” pada kolom pencarian, kemudian klik “Install” seperti Gambar 

11, Pastikan komputer/laptop terhubung dengan internet. Tunggu sampai proses 

downloading selesai. 

 

Gambar 11. Tampilan Board Manager 

 

 
6. Jika sudah selesai proses instalasinya, silahkan colokkan ESP32 DEVKIT ke port 

USB komputer. Kemudian pilih jenis board yang akan digunakan Tools > Board > 

ESP32 Dev Module seperti Gambar 12. 

 

Gambar 12. Tampilan Board Manager 

 

 
7. Pilih nomor Port-nya, cek di Device Manager. Sesuaikan nomor port, dari menu 

Tools > Port seperti Gambar 13. 
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Gambar 13. Tampilan Pemilihan Port 

 

  Pastikan port sesuai di Device Manager: 

 

 
  Jika ada masalah di bagian ini, download driver untuk mengenali port di:  

  https://www.silabs.com/developers/usb-to-uart-bridge-vcp-drivers?tab=downloads 

  dan pilih CP210x Universal Windows Driver. 

 

https://www.silabs.com/developers/usb-to-uart-bridge-vcp-drivers?tab=downloads
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1.3. Platform IoT 

Agar board ESP32 dapat terhubung dengan perangkat dan aplikasi IoT lainnya maka 

diperlukan suatu Platform IoT, Platform IoT merupakan sistem hardware dan software untuk 

mengelola perangkat IoT untuk mengumpulkan, menyimpan, memvisualisasikan, dan 

menganalisis data dari perangkat tersebut. Adapun contoh Platform IoT yang sering digunakan 

diantaranya: 

1. Blynk, 

2. Thingspeak, 

3. Ubidots, 

4. Mydevices, 

5. Temboo, 

6. Thinger.io, 

7. Thingsboard, dan lain-lain. 

Fungsi dari Platform IoT di atas bervariasi, meskipun semua Platform IoT akan memiliki 

dashboard untuk menampilkan data, namun pada praktiknya beberapa Platform IoT hanya 

memiliki dashboard, yang hanya mampu menampilkan data dari perangkat. Sebagai dasar 

untuk membuat Platform IoT maka Platform yang cocok untuk digunakan para pemula adalah 

Blynk dan Ubidots. Blynk digunakan untuk menampilkan data dari perangkat smartphone dan 

Ubidots digunakan untuk memvisualisasikan dan menyimpan data dari ESP32 ke dalam 

database cloud. 

 
a. Blynk 

Blynk merupakan Platform baru yang memungkinkan pengguna dengan cepat 

membangun interface untuk mengendalikan dan memantau proyek hardware yang telah dibuat 
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dari iOS dan perangkat Android (Community Cybereye, 2016). Gambar 14 menunjukan Logo 

Blynk. 

Gambar 14. Logo Blynk 

 

 

Setelah mendownload aplikasi Blynk, pengguna dapat membuat dashboard proyek dan 

mengatur tombol, slider, grafik, dan widget lainnya ke layar. Dengan menggunakan widget, 

pengguna dapat mengaktifkan pin dan menonaktifkan atau menampilkan data dari sensor yang 

dipakai, proses pembuatan lembar kerja ditunjukan pada Gambar 15. 

 

Gambar 15. Proses pembuatan lembar kerja 

 

 

Aplikasi Blynk menjadi salah satu Platform yang paling sering digunakan karena 

pemakaiannya yang mudah dan mudahnya mengakses source code untuk setiap perintah- 

perintah yang ada di dalam aplikasi Blynk tersebut, aplikasi Blynk setidaknya memberikan 

limit berupa 2000 poin untuk setiap pengguna baru sehingga jika pengguna ingin mengakses 

maka pengguna tidak dikenakan biaya apapun. Lembar kerja Blynk ditunjukan pada Gambar 

16 dan Gambar 17 merupakan Tampilan Widget Box Blynk. 
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Gambar 16. Lembar kerja Blynk 
 

 

Gambar 17. Tampilan Widget Box Blynk 

 
 

b. Ubidots 

Ubidots merupakan sebuah IoT cloud atau platform internet of things yang berasal dari 

Boston, Amerika Serikat. Platform ini bertujuan untuk mempermudah pembuat dalam 

pengambilan data dari sensor dan mengubahnya menjadi Informasi. Ubidots digunakan juga 

untuk mengatur aksi yang dilakukan atau memberikan peringatan berdasarkan data yang 

didapat. Ubidots menyediakan API untuk membantu proses pengumpulan data dan 

menjadikannya sebagai informasi (Kuriando et al., 2017). Logo Ubidots ditunjukan pada 

Gambar 18. 

 
 

Gambar 18. Logo Ubidots 
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API adalah sebuah cara atau solusi agar benda dapat berinteraksi dengan web. API ini 

memungkinkan para pembuat untuk melakukan perubahan dan pengambilan data dari server. 

API ini mendukung penggunaan HTTP maupun HTTPS. Untuk melakukan pertukaran data 

diperlukan API key. Untuk mengambil sebuah nilai atau variabel dari server maka diperlukan 

ID dari variabel tersebut dan token akun user yang telah diberikan server. Untuk memudahkan 

developer Android, Ubidots telah menyediakan library yang berfungsi untuk mempersingkat 

penulisan HTTP request dalam bahasa JAVA. Tampilan Web Ubidtos ditunjukan pada Gambar 

19. 

 

Gambar 19. Tampilan Web Ubidots 

 
 

Ubidots mendukung beberapa perangkat seperti Arduino, Raspberry Pi, Particle, 

Espressif, Onion dan banyak lagi. Selain itu, ada beberapa jenis layanan yang berbeda dari 

konektivitas perangkah hingga visualisasi data. Beberapa fitur yang dimiliki oleh Ubudots 

antara lain adalah sebagai berikut : 

1. SDK/API: Ubidots menyediakan SDK untuk perangkat yang berbeda – beda yang 

memudahkan proses integrasi perangkat dengan platform. Selain itu juga ada API yang 

bisa dipanggil untuk berinteraksi dengan platform 

2. Mendukung protokol MQTT dan HTTP 

3. Synthetic Variabel yang bisa menerapkan formula matematika pada data 

4. Penyimpanan data 

5. Visualisasi data 
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